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 Introduction 
PneuMotion is a simulation software package that provides an accurate working simulation of 
pneumatic devices and circuits. It enables students to study and understand the principles of 
pneumatics. 

As a design tool, PneuMotion allows students to create, operate and observe a model circuit. The circuit 
can be printed, altered and improved as needed. 

PneuMotion can be used in conjunction with the JobMaster Training Station (JMTS) panel, on which 
actual circuits with working components can be assembled and operated. 

 

 Installation and Activation 

2.1. SYSTEM REQUIREMENTS 

The minimum PC requirements are required for PneuMotion: 

• Intel Core 2 Duo CPU E840 

• 2 GB RAM (4 GB Recommended)  

• Windows 8/8.1 Pro and above, or Windows 10 Pro and above  

• Hard drive with at least 1 GB of free disk space  

• USB or RS232 port  

 
 Note: Your operating system may have additional hardware requirements. 
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2.2. INSTALLING THE SOFTWARE 

This section describes how to install the PneuMotion software.  

See the Intelitek Software Licensing Guide for other methods of registration.  

 
 Note: PneuMotion can only be licensed using Workstation licensing. 

To install the software, do the following: 

1. Start Windows. 

2. Close any open applications before you begin the installation. If you are about to reinstall the 

software or install a newer version to an existing PneuMotion directory, it is recommended that 

you backup any existing user-created files before you begin the installation. It is also 

recommended that you remove the previous PneuMotion installation by means of the Uninstall 

utility included with the software. 

3. Download and run the PneuMotionSetup.exe file. The welcome screen is shown. 

 

http://intelitekdownloads.com/Software/Automation/
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4. Click Next. The License Agreement is shown. 

 

5. Check I accept and click Next. The Controller Type screen is shown. 
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6. Select the Controller Type and click Next.  The Interface Language is screen is shown. 

   

7. Choose your desired language and click Next. The Choose Destination Location screen is shown. 

By default, the software is installed to the folder C:\Intelitek\PneuMotion. During the installation 

process you have the option to change this. It is not recommended that you do so. 
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8. Click Next. The Select Program Folder screen is shown. 

 

9. Click Next. The Setup Status screen is shown. When the status bar completes the InstallShield 

Wizard Complete screen is shown. 

 

10. Click Finish to exit the InstallShield Wizard. 

When the installation is complete, the PneuMotion icon  will appear in the Windows 

program menu.  
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 Note: During setup, you may be prompted to install additional items, such as in this image.  
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2.3. UNINSTALLING THE SOFTWARE 

This section describes how to uninstall your software. Before you uninstall the software, you should 
backup any existing user-created program and position files.  

 
 Note: If required, before you uninstall the software you can return your license to Intelitek (and 

retrieve it later). For further details refer to the Intelitek Software Licensing Guide.  

 Note: After the license is removed, PneuMotion cannot be used. 

To uninstall PneuMotion: 

1. From your windows Start menu, select Settings (gear icon) | Apps.  A list of apps and features 

are displayed. 

2. Select PneuMotion to and then select Uninstall to remove all PneuMotion software 

components. Follow the instructions that appear on the screen. 

 

2.4. ACTIVATING THE SOFTWARE 

To activate PneuMotion: 

1. If you will be using PneuMotion with a JMTS panel, make sure that all hardware has been 

properly set up and connected according to the installation procedures detailed in the user 

manuals. 

2. Turn on the computer and all other connected hardware. 

3. From your Windows Start menu, select All Programs | PneuMotion | PneuMotion.   
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The PneuMotion application window is displayed. 

 

2.5. QUITTING THE SOFTWARE 

To quit PneuMotion, use any of the standard Windows methods for closing a program: 

• In PneuMotion, select File | Exit. 

• Double Click the Control-Menu box in the Title Bar. 

• Press [Alt]+F4. 
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 Overview 

3.1. THE PNEUMOTION WINDOW 

The elements of the PneuMotion main window are shown in the following diagram: 

 

 
 Title Bar Contains the usual Windows right-click menu consisting of 

controls for sizing and closing the application screen as well 
as an additional option enabling you to display the interface 
on top at all times.  

 Menu Bar Contains menus with PneuMotion commands. Some 
commands are accessible from the tool bar (buttons), while 
some are accessible only in the menus. 

 Tool Bar Contains buttons that represent the most frequently used 
functions and commands. Button availability varies according 
to the currently active screen or mode, or the selected 
component. 

 Drawing Area Screen area used for designing and displaying circuits 

 Status Bar Displays, at the bottom of the screen, information regarding 
the PneuMotion software, modes of operation, current 
activity, and so on. When you position the mouse over an 
icon, a description of the icon appears in the status bar. 

Menu Bar 

Tool Bar 

Title Bar 

Drawing Window Bar 

Status Bar 

Menu Bar 

Tool Bar 

Title Bar 



 

3 Overview  

3.3 Edit Menu 10 

 

3.2. FILE MENU 

 

The File menu contains the usual Windows functions which allow you to load, save 

and print files containing pneumatic circuit diagrams and connections, and to exit the 

software. 

Only one file can be opened and edited at a time, however you may open a second 
window to create and edit a second file. 

 New  [Ctrl]+N Opens a new, untitled file. 

 
Open  [Ctrl]+O Opens an existing file. 

 
Save  [Ctrl]+S Saves the currently active file. 

 Save As... Saves the currently active file under a new file name. 

 
Print  [Ctrl]+P Prints the currently active file. 

 Delete... Deletes a previously saved file. 

 Exit Quits PneuMotion. 

If changes have been made to a file, but not yet saved, a 
warning message will be displayed. 

For more information on file management, see Chapter 8. 
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3.3. EDIT MENU 

 

The Edit menu contains usual Windows functions found in most drawing 

programs. These allow you to edit cross section and schematic diagrams. 

 Copy  [Ctrl]+C Copies a selected component to the clipboard as a 
regular drawing object. It can then be pasted into 
any other program. 

 
Duplicate Makes a copy of the selected component. 

 
Rotate Right F7 Rotates the selected component 90° to the right. 

 
Rotate Left Rotates the selected component 90° to the left. 

 
Mirror                 F8 Turns the selected component over from left to 

right. 

 
Flip Vertical        F9 Turns the selected component over from end to end. 

 
Delete  [Del] Deletes the selected component. 

 
Parameters           ! Sets values for selected components. This option is 

only available for those components that have 
variable parameters. 

For more information on editing functions, see Chapter 4. 
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3.4. VIEW MENU 

 

The view menu contains the commands for the viewing modes available in 

PneuMotion. 

 
Cross Section Displays a cross section view of each component. 

 
Schematic Displays the components in standard schematic 

form. 

 
Ladder Diagram Opens a schematic control flow chart for electro-

pneumatic circuits. 

 
Time Diagram Shows the timing (activation) of different 

components in a circuit. 

 
Zoom In Magnifies the current view. 

 
Zoom Out  [Ctrl]+Z Returns the view to normal. 

For more information on viewing, see Chapter 6. 

3.5. COMPONENTS MENU 

 

The Components menu contains the commands for selecting the PneuMotion 

Component List and Library. 

 
List  [Ctrl]+F2 Opens a list of the PneuMotion components organized 

by category. 

 
Library               F2 Opens a graphic library of the PneuMotion 

components and devices. 

For more information on selecting components, see Chapter 4. 
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3.6. CONNECTIONS MENU 

 

The Connections menu contains the commands for connecting components 

in PneuMotion. 

 
Connect Components   
F5 

Selects the Connect Components view. 

 
Delete All Connections Deletes all connections in the circuit. 

 Link PBs Links two or more push button switches together. 

 Clear PB Links Disconnects any PB links in the circuit. 

 
Create Ladder Diagram Creates or edits a ladder diagram for electro-

pneumatic simulations. 

For more information on making connections, see Chapter 5. 

3.7. SIMULATION MENU 

 

The Simulation menu contains the commands for simulating a pneumatic circuit, 

and individual components in PneuMotion. 

 
Circuit Selects the PneuMotion simulation feature. 

Simulation is available only when the Cross- Section 

display mode is active. 

 
Component Activates the simulation of a component. 

For more information on simulation modes, see Chapter 7. 
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3.8. INTERFACE MENU 

 

The interface menu contains the commands for online software operation. 

 Setup                  # Configures the hardware and software for online 
operation. 

 Display I/Os Provides graphic tracking of the inputs and outputs 
during online operation. 

 COM Test Tests communication between the hardware and 
software. 

For more information about on line operation, see Chapter 9. 

3.9. WINDOW MENU 

 

The Window menu defines how the windows containing circuit diagrams are 

displayed on the screen. 

 
Open Main Window Opens a new main window. 

 
Close Main Window Closes the main window if it is open. 

 
Open 2nd Window Opens a new second window. 

 
Close 2nd Window Closes the second window, if it is open. 

 Cascade The usual Windows control for resizing and layering 
open windows so that each bar is visible. 

 Tile The usual Windows control for resizing and 
arranging the open windows by size. 

 Arrange Icons The usual Windows control for realigning the icons of 
programs that have been minimized. 
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 Close All Closes all open windows that are used for program 
editing. 

The Cascade or Tile setting remains in effect until changed. 

3.10. HELP MENU 

 

The Help menu contains commands for viewing the software version information 

as well as the software licensing options.    

 About  Opens the About PneuMotion dialog box containing 
the current software version information.    

 Registration  Opens the License window enabling you to see your 
license status. 

In order to see the Registration dialog box, you need to 
run the application as an administrator. This enables 
you to perform various registration options, such as 
obtaining and retrieving your software license from 
Intelitek’s web site, e-mail, fax or phone.        
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 Components 
The Components menu allows you to select components and include text in your circuit diagrams. 

You can perform the following functions on components that have been placed in the drawing area: 
• Move • Rotate 

• Flip • Resize 

• Delete • Copy 

4.1. SELECTING COMPONENTS 

To view and place components in a circuit diagram, use either of the following: 

• Component List dialog 

• Components Library 

4.2. THE COMPONENT LIST 

 
Select Components | List or click the Component List button. The component 
list dialog box opens. 
 

 

To place components from the list into the drawing area, do the following: 

1. Select a category from the Groups list. 

(If you double click on one of the category names, the component library [graphic display] 

appears). 

2. Select a component from the list. 

3. Click OK. 

4. Click on the drawing area. The component appears at the point where you click on the drawing 

area. 
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The placement does not have to be exact; you can move components after you have placed 

them in the drawing area. 

You may place as many components as you need in the drawing area. 

5. Click Cancel to close the dialog box. 

4.3. THE COMPONENT LIBRARY 

 
Select Components | Library, or click the Component Library button. 

The Components window opens. 

 

 

The components are shown either in cross section or as schematics depending 
upon the currently active display mode. 

You can move and resize the Components window, if necessary. You may need 
to use the horizontal scroll bar at the bottom of the window to find the 
component. 
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To place components from the library into the drawing window do the following: 

1. Click on the picture of the component you want to use. 

2. Click on the drawing area. The component appears at the point where you click on the drawing 

area. 

3. The placement does not have to be exact; you can move components after you have placed 

them in the drawing area. 

4. When you are finished placing the components in the drawing area, click anywhere in the 

drawing area to close the Component Library. 

4.4. MANIPULATING COMPONENTS 

Once you have placed components in the drawing area, you can manipulate and arrange them. 

Click on a component to select it. 

A frame with handles is drawn around the selected component. 

 

 

4.5. MOVING COMPONENTS 

To move a component, do the following: 

1. Click on the component. A frame will be drawn around it. 

2. Click and drag the component to the desired location. 
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4.6. ROTATING COMPONENTS 

   
To rotate a component do the following: 

1. Click on the component. A frame will be drawn around it. 

2. Select Edit | Rotate Right or Edit | Rotate Left. 

OR 

3. Select the Rotate Right, or Rotate Left button. 

4. The component is rotated 90° to the right or left. 

 

4.7. FLIPPING COMPONENTS 

 
To flip a component, do the following: 

1. Click on the component. A frame appears around the component. 

2. Select Edit | Flip OR click the Flip button. 

The component is flipped over. The top and bottom sides are reversed. 

4.8. MIRRORING COMPONENTS 

 
To mirror a component, do the following: 

1. Click on the component. A frame appears around the component. 

2. Select Edit | Mirror OR click the Mirror Button. 

The component is mirrored. The left and right sides are reversed. 

4.9. RESIZING COMPONENTS 

To resize a component, do the following: 

1. Click on the component. A frame appears around the component. 

2. Place the mouse on one of the frame handles. 

The cursor changes to a double arrow. 

3. Click and drag the handle to readjust the size of the component. 
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OR 

Use the + and - keys to resize the selected component. 

4.10. COPYING COMPONENTS 

 
To copy a component in the circuit diagram, do the following: 

1. Click on the component. A frame appears around the component. 

2. Select Edit | Duplicate, or click the Duplicate button. 

A copy of the component appears on top of the original component. The 
duplicate component is now selected, and can be manipulated. 

You can orient, move, or resize the copied component as needed. 

The File | Copy command places the selected component on the Windows 
clipboard. This allows you to paste a component into another application as a 
graphic object. It does not make a copy of the component in the circuit diagram. 

4.11. DELETING COMPONENTS 

 
To delete a component, do the following: 

1. Select the component you want to delete. 

2. Select Edit | Delete, or click the Delete Object button. A dialog box 

opens. 

 

3. Click Yes to delete the component. 

4.12. ADDING TEXT 

PneuMotion allows you to add text to your circuit drawings. To add text, do the following: 

1. Select either the Components List or the Components Library. 

2. Select the Text object, in the list or library. 

3. Place the text object anywhere in the drawing area. 
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4. Close the list or library. 

5. Select the text object, if not already selected.  

6. To enter text in the Input Text dialog box do one of the following: 

▪ Press [Enter]. 

▪ Double click on the text object. 

7. Replace “TEXTO” with the text you want to appear in the circuit diagram. 

 

8. Click OK. 

The text now appears as an object in the circuit diagram. You can manipulate it in the same way as any 
component. Text cannot be flipped horizontally or vertically. 

4.13. COMPONENT PARAMETERS 

You can set values for the following components: 

• Double Acting Cylinder (extension and retraction time) 

• Cylinder with Roller Valve (extension and retraction time) 

• Pneumatic Delay (time interval) 

• Pneumatic Counter 

• Cylinder with Magnetic Limit Switch (extension and retraction time) 

• Timer (time) 

• Electric Counter 

4.14. EDITING COMPONENT PARAMETERS 

 
To set the component parameters do the following: 

1. Select the component whose parameters you want to view or change. 

2. Select Edit | Parameters, or click the Component Parameters button, 

the Input Parameter dialog box opens. 

3. If more than one variable appears in the list, select the one you want to 

view or change. 

4. The current value of the selected variable is displayed. You can change 

this value by typing a new value, or by selecting a value by means of the 

scroll bar under the field. 
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5. Click OK. 
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 Connections 
Components and devices are connected on the screen by means of colored lines that represent 
pneumatic and electrical connections. 

Connected components cannot be rotated, flipped, or resized. They can be moved or deleted. 

Deleting a connected component will also delete all lines connected to it. 

5.1. CONNECTING COMPONENTS 

5.1.1. Making Pneumatic Connections 

 
To connect components do the following: 

1. Select Connections | Connect Components, or click the Connect 

Components button. 

A grid of dots appears in the drawing area, indicating that components 

can now be connected. In addition, black boxes with white borders 

appear at component ports where connections can be made. 

 

 

2. Place the mouse pointer on an available port. The border turns green, 

indicating a connection can be made. 

3. Click the mouse, a blue arrow appears indicating the first port has been 

selected. 
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Optional: You may route the connection between an inlet and an outlet by 
clicking the mouse to make right angle turns along the route. A red line will 
mark the path as you create it. You can use this option to route lines around a 

component. 

4. Bring the mouse pointer to the second port. The border turns green. 

5. Click the mouse, a light blue line now connects the two components. 

 

5.1.2. Making Electro-Pneumatic Connections 

 
Connecting electronic components is similar to connecting the pneumatic 
components. 

To connect electronic components do the following: 

1. Select Connections | Connect Components, or click the Connect 

Components button. 

Electronic components have colored circles to indicate their sockets. 

Red sockets are live. Blue sockets are ground. 

On switches and relays, red sockets are normally closed, black sockets 

are normally open, and blue sockets are common. 

2. Place the mouse pointer on the first socket, the socket turns green 

indicating a connection can be made. 

3. Click the mouse, a light blue arrow now appears, indicating a socket has 

been selected. 

4. Bring the mouse pointer to the second socket. The socket turns green. 

The path will be indicated by an aqua line as you drag the mouse to the 

second port. 

Optional: you may route the connection between sockets. Click the 

mouse to make right angle turns along the path. Aqua-colored lines 

mark the path as you create it. You can use this option to route lines 
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around a component. 

 

5. Click the mouse. The line turns red, indicating the connection has been 

made. 

5.1.3. Deleting one Connection 

To delete a connection, do the following: 

1. Place the mouse pointer on the line you want to delete. Do not click. The connection will blink 

and change color. 

2. Press [Del], the connection will be deleted. 

5.1.4. Deleting All Connections 

 
To delete all of the connections do either of the following: 

• Select Connections | Delete All Connections. 
 
OR 

• Click on the Delete All Connections button. 

All connections are deleted. 

5.1.5. Erasing an incomplete Connection 

To erase a partially complete connection, press [Del]. 

The line is deleted. 

5.1.6. Changing the Second Port of a Connection 

To change an existing connection, do the following: 

1. Place the mouse on the line you want to delete. The connection will blink and change color. 

2. Click on the line you want to change. 

3. The line changes color. The second port is disconnected while the first port remains selected. 

4. Click on the port you want for the new connection. 
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The new connection is displayed. 

5.1.7. Exiting the Connections Window 

 
To exit the Connections window do either of the following: 

• Click on the Close Connections button. 

OR 

• Press [Esc]. 

The dot grid disappears and you can perform other operations on your circuit 
diagram. 

5.2. LINKING PUSH BUTTONS 

For safety reasons, a pneumatic circuit may require simultaneous (two handed) operation of two push 
buttons. Since you can only click one button at a time, the push button link option allows you to 
simulate simultaneous, two-handed, activation of the push buttons. 

Push button links can be made only when the Cross-Section display mode is active. These links cannot be 
made when the Connections or Schematic mode is active. The links can be removed, however when any 
display mode is active. 

To link two push buttons, do the following: 

1. Select Connections | Link PBs. 

You are prompted to select the master push button. The master is the push button that controls 

both push buttons. 

2. Click on the PB that you want to serve as the master. 

The letter M is now displayed inside the component. 

You are prompted to select the slave push button. The slave is the push button that is controlled 

by the master. 

3. Click on the push button that you want to serve as the slave. 

The push buttons are now a linked pair, as indicated by an identical digit (e.g., M1 and S1) 

 

Whenever you activate the master push button, the slave button is also activated. However, the 

slave push button remains operable on its own. 
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5.2.1. Disconnecting One Pair of Linked Push Buttons 

To disconnect the links between a selected pair of push buttons, do the following: 

1. Select Connections | Link PBs. 

2. Lines appear showing all pairs of linked push buttons. 

3. Place the mouse pointer on the line you want to delete. Do not click. 

4. Press [Del], the connection will be deleted. 

5.2.2. Disconnecting All Push Button Links 

To disconnect the links between all push buttons Select Connections | Clear PB links. 

All push button links are removed. 

5.3. LADDER DIAGRAMS 

5.3.1. Creating a Ladder Diagram 

 
You can make electro-pneumatic connections by means of a ladder diagram. 

To create a ladder diagram, do either of the following: 

• Click on the Edit Ladder Diagram button. 
 
OR 

• Select Connections | Create ladder Diagram. 

The Create Ladder Diagram window opens. 
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5.3.2. Creating a Circuit from a Ladder Diagram 

The Create Ladder window has two parts. The top half shows the ladder diagram, the bottom half shows 
a table of electro-pneumatic components. (Components whose names appear in black have been placed 
in the drawing area and can be connected in a circuit). 

 Note: The table of electro-pneumatic components is limited to the default components in the 

table. Any additional components added to the drawing area will not be displayed in the table.  

To connect components by means of the ladder diagram, do the following: 

1. Click on a black component in the table. 

2. The cell will turn white, and the cursor changes to a boxed +. 

3. Click on the ladder diagram rung where you want to place the component. 

4. The component now appears in the ladder diagram. 

Use the buttons at the top of the window to make, change or delete the connections. 

 
 

Checks the Connections  

If a connection or component turns red the connection is faulty. If nothing happens, the 
connection is OK. 

Although the connections test is successful the actual components on the panel may not be 
properly connected. 

 
 

Connects Components When selected, the cursor turns into a wand. 

Black lines indicate a connection. Click on the blue lines to turn them black (connect). 

Make Connection. 

(Will turn black when 
connection is made). 

 

Rung 
 

Component 
Table 
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Deletes components or connections. When selected, the cursor turns into a wire cutting tool. 

Place the cursor on the connection or component you want to delete, and click. 

 
 

Moves a rung in the ladder diagram down one line. When selected, the cursor turns into a 
shaded square. 

Place the cursor on the rung you want to move, and click. The rung moves down one line. 

 
 

Saves the connections made in the ladder diagram and exits to the main window. 

All connections make in the ladder diagram now appear in the circuit diagram. 

 
 

Closes the Create Ladder Diagram window without saving the new connections. 

Any connections made in the ladder diagram will not appear in the circuit diagram. 
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 Views 
The View menu allows you to select the view in which the components are displayed. Two basic display 
modes are available: 

• Cross-Section 

• Schematic 

The Zoom In and Zoom Out options can be used when either display mode is active. 

In addition, the view menu allows you to display two types of diagrams: 

• Ladder Diagram 

• Time Diagram 

6.1. CROSS SECTION DISPLAY 

The Cross-Section display mode provides a cross-section illustration of the components, as shown in the 
picture at the right. The different colors allow you to see airflow of each component. 

 

 

The cross-section allows you to observe the following: 

• Operation of the circuit and components. 

• Simulated air pressure flowing through the connections and its effect on the various 
components. 

• The component’s reactions to changes in pressure. 

6.1.1. Activating the Cross-Section Display Mode 

 
To display the Cross-Section mode, do either of the following: 

• Select View | Cross-Section. 
 

OR 

• Click on the Cross Section Button. 
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6.2. SCHEMATIC DISPLAY 

The Schematic option displays the components in standard schematic form, as shown in the picture at 
right. This display mode is useful for observing and analyzing components in a pneumatic circuit or 
complex system. 

 

The Schematic display mode is for viewing purposes only. Simulation or connections cannot be 
performed in this mode. 

6.2.1. Activating the Schematic Display Mode 

 
To display the Schematic Mode, do either of the following: 

• Select View | Schematic. 
 

OR 

• Click on the Schematic button. 
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6.3. ZOOM 

In PneuMotion you can zoom in to see a section of the circuit diagram better. 

6.3.1. Zoom In 

 
To zoom in do the following: 

1. Select View | Zoom In, or Click on the Zoom in Picture button. 

2. The Choose Screen dialog box opens. 

 

3. A rectangle is attached to the cursor. Move the rectangle to select the part 

of the screen you want to enlarge, and click the mouse. 

6.3.2. Zoom Out 

 
To Zoom out do the following: 

• Select View | Zoom Out. 
 
OR 

• Click on the Zoom Out Picture button. 

The circuit diagram returns to its normal view. 

Selected Zoom 
area 
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6.4. TIME DIAGRAM 

The time diagram shows the status of a component at different times during circuit operation. It helps 
you to determine whether a component is receiving conflicting signals. 

 

 

6.4.1. Activating the Time Diagram 

 
To view the time diagram, do one of the following: 

• Select View | Time Diagram | Display. 
 

OR 

• Click on the Time Diagram button. 

To view a new time diagram, do one of the following: 

 

• Select View | Time Diagram | New. 
 

OR 

• Click on the Time Diagram button. 

To change which push button the time diagram will start with do the following: 

1. Select View | Time Diagram | Start With. 

2. The Select Push Button for Start Timing Diagram dialog box appears. 

3. From the list, select the push button with which the timing will start. 

4. Click OK. 
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6.5. LADDER DIAGRAM DISPLAY 

A ladder diagram is a schematic control flow chart for electro-pneumatic circuits. It is automatically 
generated by the software according to electrical connections you make in the diagram. 

6.5.1. Displaying the Ladder Diagram 

 
To display the ladder diagram of the circuit diagram in the currently active 
window, do either of the following: 

• Select View | Ladder Diagram. 
 

OR 

• Click on the Display Ladder Diagram button. 

The Ladder Diagram window opens. 

 

 

6.5.2. Closing the Ladder Diagram 

 
To close the ladder diagram, click on the Exit Ladder Diagram button, or use any 
standard Windows method for closing a window. 
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 Simulation 
The simulation mode allows you to observe the operation of a component working independently or as 
part of a whole circuit. 

Simulation is available only when the Cross-Section display mode is in effect. 

7.1. SINGLE COMPONENT SIMULATION 

You can simulate the operation of any single component displayed in cross-section. There are two 
options available for single component simulation. 

• Automatic step by step: This simulation displays continuously changing states of the selected 
component. This is the default setting. 

• Manual step by step: This simulation shows each state of the selected component one at a 
time. You must continuously click the component to display each state. 

7.1.1. Simulating a Component Automatically 

 
To automatically simulate operation of a single component, do the following: 

1. Select the component you want to simulate. 

2. Select Simulation | Component | Automatic Stepped. 

OR 

Click the Single Component Simulation Auto Stepped Button. 

7.1.2. Simulating a Component Manually 

To manually simulate operation of a single component, do the following: 

1. Select the component. 

2. Select Simulation | Component | Manual Stepped. 

3. Click on component to change the state of the component. 

7.1.3. Stopping the Simulation of Single Components 

 
Exit the simulation mode to make changes in the circuit diagram. 

To stop the component simulation, click on Exit from Single Component 
Simulation button. 

The normal viewing mode is resumed. 
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7.2. CIRCUIT SIMULATION 

 
PneuMotion allows you to simulate the operation of an entire circuit. 

To view the simulation of an entire circuit do one of the following: 

• Select Simulation | Circuit. 
 

OR 

• Click on the Simulate Circuit button. 

Once you are in the simulation mode, you can click on any push button that is in 
the diagram to see how they will affect the pneumatic circuit. 

When you have finished viewing the simulation, you must return to normal 
mode. 

7.2.1. Stopping the Circuit Simulation 

 
To stop the circuit simulation, click on the Exit from Simulate Circuit button. 

The normal viewing mode is resumed. 
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 File Management 
PneuMotion files are managed through the standard Windows file tools, found in the File menu. 

 New           [Ctrl]+N Opens a new, untitled file. 

 

 

 
Open       [Ctrl]+O Opens a dialog box for selecting an existing circuit diagram 

file. 

 
Save          [Ctrl]+S Saves the currently active file. 

If the file is untitled, a dialog box opens for defining the file 
name. By default, the system provides a file name (e.g. 
PN0031.BIN). You may give the file any title you want. The 
file name must contain only English characters or numerals. 
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 Save As Saves the currently active file under a new file name.  

The Save File dialog box opens. Enter a new name in the Title 

field. By default the system provides a file name (e.g., 
PN0031.BIN). 

 
Print           [Ctrl]+P Prints the currently active file. 

 Delete... Opens a dialog box with a list of previously saved files. 

Choose a file that you want to delete and click OK. 

 

 

 Exit 
Quits PneuMotion. 

If changes have been made to a file, but not saved, a warning 

message is displayed. 
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 System Setup 

9.1. PROGRAM WINDOWS 

The Window menu contains Windows commands for the display of the program windows. 

 
Open Main Window Opens a new main window. 

This command functions the same as File | New. 

 
Close Main Window Closes the active main window. If changes have been 

made, but not yet saved, a warning message will be 
displayed. 

The button toggles between open and close. It opens a 
window if one is not currently active, and closes a window if 
one is currently active. 

 
Open 2nd Window Opens a new second window. 

The second window will open under the main window. It 
functions in the same way as the main window. It can be 
moved and resized. 

Only the main and 2nd windows can be open at the same 
time in PneuMotion. 

 
Close 2nd Window Closes the active second window. If changes have been 

made, but not yet saved, a warning message will be 
displayed. 

The button toggles between open and close. It opens a 
window if one is not currently active, and closes a window if 
one is currently active. 

 Cascade The usual Windows control for resizing and layering open 
windows so that each title bar is visible. 

 Tile The usual Windows control for resizing and arranging the 
open windows by size. 

 Arrange Icons The usual windows control for realigning the icons of 
programs that have been minimized. 

 Close All Closes all open windows that are used for program editing. 

The Cascade or Tile setting remains in effect until changed. 

9.2. ONLINE OPERATION 

PneuMotion can be used to control actual electro-pneumatic circuits and to provide graphic tracking of 
the JMTS laboratory panels. 
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The CIC Unit (PLC MicroLogix) is required for the software-hardware interface. Refer to the 
documentation provided with the panel and the CIC Unit (PLC MicroLogix) for installation instructions. 

For information on how to configure the PneuMotion software when working in online operation, see: 

• Configuring the Software for Online Operation (PLC MicroLogix) 

9.2.1. Configuring the Software for Online Operation (PLC MicroLogix) 

To configure the software for online operation, do the following: 

1. Make sure the computer, the panel; the PLC and the power supply are all properly connected, as 

shown in the example below. 

 

  

Schematic of PLC Connected to Power Supply and Panel 

1 Power Supply Module  

2 Operational Module  

3 MicroLogix PLC Module 

4 Conditioning Unit 

5 5/2 Sol-sol Control Valves 

6 Double-Acting Cylinder  

7 Main Power Cable 

8 Electrical Connections 

9 Pneumatic Connections 
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2. Use PneuMotion to load or draw an electro-pneumatic circuit, which is (or will be) assembled on 

the JMTS panel.  

The figure below shows the circuit drawn in PneuMotion. 
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3. Select Interface | Setup. The Setup dialog box opens. This box allows you to select the 

components that are controlled and tracked by the software. 

 

All electrical input and output connections made in the circuit diagram are available in the Setup 

dialog box. 

4. Using the check boxes, select the components which will operate online. Once components are 

selected online operation, they respond to external I/O signals only. PneuMotion graphically 

tracks the operation of these components (and does not simulate their operation). 
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5. Click the Controller Configuration button. The following configuration window is displayed. 

 

6. From the Comm Port drop down list, select the required COM port and click Apply and then click 

Close. A confirmation message is displayed.  

7. Click Yes. A message is displayed requesting you to restart your application. Click OK. 

8. Click OK again to close the Setup window and return to the  PneuMotion main window. 

9. Select Interface | COM Test to communicate with the controller. One of the following options 

will appear on the status bar on the bottom right hand corner of the window:  

• : Indicates the PneuMotion is communicating with the PLC MicroLogix controller.  

• : Indicates no communication exists between the PneuMotion software and the 
controller. In this case perform the following: 
 

▪ Check that your default parameters correspond to the parameters in the controller 

configuration window shown in step 4, above. 

▪ Check the communication cable connections between the PLC MicroLogix and your 

computer.  

 Note: If the problem persists, refer to technical support for further assistance.                   

 


